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[bookmark: _Toc480989727] 
ABSTRACT 
Abstract is 1-page long. The headline of the abstract is not numbered, it is written in capital letters, with an 11-point bold type font, Times New Roman CE, and the space before and after the heading is 12 points.
The text of the abstract is written in 11-point font, Times New Roman CE; paragraph indentation is 0.5 cm. Text formatting should include automatic word breaks. The first chapter heading following the abstract should start on the new page. The header of each subsequent chapter should be on the new page.
The page header, in addition to the title page, contains:
· on the even page: name and surname (9 pt font, centered) and page number (11 pt font, justified to the left),
· on the odd page: the title of the work (9 pt font, centered) and page number (11 pt font, justified to the right).
This electronic version of the editing template contains formatting styles developed in accordance with the description provided. The pattern is the basis for editing diploma thesis and it can be changed in agreement with the supervisor.
[bookmark: _Toc415728433][bookmark: _Toc480989728]
TITLE OF THE CHAPTER (adjusted to the left, 14 pt, bold) 
[bookmark: _Toc480989729]Subtitle of the chapter (adjusted to the left, 12-point font, bold, 18 pt before and 12 pt after the header)
The thesis should be written in 11-point font, Times New Roman CE, with a spacing between rows set to 14 points, all margins are 2.5 cm (+ 0.5 cm margin on the left side), and indentation of the paragraph: 0.5 cm.
Every enumeration in the subsection should start with a paragraph with a hyphen; the next line of the given enumeration should be justified to the left, which is as follows:
· enumeration of the first degree begins with a "long" dash, i.e. the character "",
· it should be noted that on the standard keyboard there is a short dash, i.e. the hyphen "-", which is used to connect words, e.g. physico-chemical, but it should not be used as a hyphen;
If the enumeration is double, the rule should be applied that the first level of enumeration has a letter symbol, e.g. an additional indentation should be applied to the first level of the enumeration, e.g.:
a) enumeration of the first degree in a two-step list should be made using letters,
the enumeration of the second degree in a two-step list should be carried out with dashes.
[bookmark: _Ref226797908][bookmark: _Ref226797914][bookmark: _Toc480989730]Subsection (adjusted to the left, 12-point font, bold, 12 pt before and after the header)
The content of the thesis should contain literature references, indicating the source of the theory used and the opinions quoted. The reference should be placed after the cited author's name or at the end of a sentence (thought) that comes from the cited material. The number of the cited reference must correspond to the number from the reference list at the end of the thesis. Both examples are presented below:
E. Jacquet-Lagrèze i Y. Siskos [2] propose the classification of criteria in which they simultaneously take into account both the method of modeling preferences and the precision of the value of the criterion (...). 
According to R. Słowiński, an attribute is a feature of a variant which, unlike the criterion, does not have a clearly defined direction of preferences [3].
In order to facilitate the management of the bibliographic set cited in the work, a procedure has been developed that helps the final editing of the reference list itself (sorted in an alphabetical order), as well as updating the references (citations) in the thesis. The procedure is as follows:
Add a reference to the list in accordance with the requirements (note - the numbering of a subsequent reference is assigned automatically), e.g. item 1 in the reference list (see page 12), i.e. Curkovic S., Vickery S. H., Droge C.: Quality and business performance: an empirical study of first-tier automotive supplier. Quality Management Journal, Vol. 6, No. 2, 1999, pp. 29–40.
In the appropriate place of the thesis, a reference to the work from the reference list should be placed by:
inserting square brackets in the place where the reference should be placed, for example: "In the opinion of S. Curkovic, S.Vickery and C. Droge [] it is necessary ...",
inserting a reference, i.e. an appropriate number from the list of references); however, do not enter the number manually, but place the cursor between square brackets and select the "Reference" option from the "Insert" menu (see figure 1).
[image: ]
Figure 1. Selection of an option to insert a cross-reference [own work]
Then, from the available list, select "Cross-reference" - as "Numbered item" (see figure 2).
[image: ]
Figure 2. Selection of the link type from the list [own work]
Additionally, select the element to which the cross-reference is inserted ("Insert reference to:") - select "Paragraph number (no context)" (see figure 3).


[image: ]
Figure  3. Selection of the paragraph number (no context) from the list [own work]
Finally, from the list of available references, select the correct one (see figure 4), i.e. 1 for the cited work, which will result in the following entry: "According to Curkovic S. et al. [1] it is necessary to...".
[image: ] 
Figure 4. Selection of the reference [own work]
[bookmark: sortowanie]After editing the thesis and closing the list of references, it should be sorted alphabetically. To do this, select all of the references (do not select the heading "References") and select the "Sort" option from the "Home” menu (tab), in the "Paragraph" group. In the Sort Text dialog box, under Sort by, select Paragraphs and Text, and then sign Ascending (see figure 5).
[image: ]
Figure 5. Selection of the references sorting option [own work]
To update the reference numbers to an ordered list of references, select the entire text of the thesis ("Ctrl + A" keys), and then right-click the "Update field" option and then "Update the entire table" (see figure 6).
[image: ]
Figure 6. Updating references to the list of references [own work]
If the author presents original achievements - his own achievements (not published anywhere yet), this should be marked as his own elaboration, in the form of the following: [own work].
The mathematical formulas used in the content of the thesis should be centered and written in 11-point font, indices and exponents of power - 7 points. The space between the preceding text and the mathematical formula, and between the legend and the following text, should be one line each. There should be no blank line between the mathematical formula and the legend, as in formula (1). Mathematical formulas must be numbered.
Formulas with numbering should be inserted into a one-line two-columns table (see example below). In the first column (width 12 cm), a centered mathematical formula is placed, while in the second column (width 1 cm), the next number, justified to the right side, is inserted.

	
 [pkm]
	
(1)


 where:
vi  number of passengers transported on the i-th section of the road,
bi  the distance traveled by passengers on the i-th section of the road.

[bookmark: _Toc480989731]Subsection (adjusted to the left, 12-point font, bold, 12 pt before and after the header)
Figures should be included in the text of the thesis in their final form (it is suggested that the figures should be previously saved in another file, and the final form should be placed in the thesis - it is definitely not recommended to create figures in the same document as the edited thesis. Figures should not be larger than it is necessary to read their content, and all axes, in the case of graphs, should be clearly described together with the unit. Figures should be made in grayscale (it is allowed to use colors if the author assumes printing of all copies of the thesis on a color printer ).
In order to avoid more frequent editing errors, the following procedure for inserting figures into the thesis content is proposed:
In the place of inserting the figure, select the formatting style as "figure" („illustration”) caption 
From the source document, copy the figure that is to be inserted into the thesis - use the classic formula, i.e. select the figure and use the "Ctrl + C" keys.
After returning to the document of the thesis, place the cursor in the place previously formatted as the "figure" („illustration”) style and select the "Paste special" option from the "Edit" menu, and then "Device Independent Bitmap" (see figure 7).
[image: ]
Figure 7. Selection of the pasted figure format [own work]
A correctly inserted figure (as described above) is characterized by a specific border and signs on the perimeter - as shown in the figure below (see figure 8).
[image: ]
Figure 8. Correctly pasted figure [own work]

The space between the text preceding the figure and the figure itself, as well as the space between the figure’s caption and the text following it, is obtained automatically by means of styles. Do not add a free line additionally. The caption of the figure should be placed under the figure (also without free space), centered, and written with the font 10 points. Do not use other names such as: graph, drawing, etc. The final form of a correctly inserted figure is shown in figure 9.
[image: Klienci firm transportowych_kolor]
Figure 9. Captions under figures should be centered, written in 10-point font, without a dot at the end of the caption [1]
You can also place tables in the text (see table 1). They should be, like the figures, not larger than it is necessary to read their content, and the text in the table should not be written in a font smaller than 10 points. The space between the text preceding the table and the table itself as well as the space between the caption of the table and the text following it should be 1 line. The caption of the table should be placed above the table (without any free space) in a centered manner, written in 10-point font. The table should be centered with the left and right page margins.
Table 1. Captions placed above the tables should be centered, written in 10-point font, without a dot at the end [own work]
	Characteristic
	Type of the characteristic

	
	Criterion
	Attribute

	Quantitative 
(measurable)
	Time of order fulfillment, 
e.g. 10, …, 24, … 36 [h],
The delay time of the order of transport, e.g. 5, 10,  16 [h].
	Vehicle loading capacity available, e.g. to 5, 6-12, 13-20, ....  [EURO pallet].

	Qualitative (immeasurable)
	The size of the vehicle, e.g. small, medium, large, extra large etc.
Exhaust smoke, e.g. very low, low, medium, etc.
	Available means of communication, e.g. mobile phone, free info-line, website, etc.



[bookmark: _Toc480989732]Subsection (adjusted to the left, 12-point font, bold, 12 pt before and after the header)
The content of the thesis is followed by a bibliography – list of references (10-point font, Times New Roman CE) in the alphabetical order, according to the examples of bibliographic record provided. The heading "REFERENCES" is unnumbered, written in all capitals, 11-point font and bold; space before and after the header is 12 points. The heading of the reference list should start on a new page.
In the case of many authors of the reference, e.g. [1] , the main author should be given in the reference, with the note (eds). In the case of articles published in journals, e.g. [1], [2], please provide exact references, including: number, volume, year and pages. Articles from conference materials should contain the author's data and the title of the article, the editor's data, the title of the conference materials, the name and year of the conference and the page numbers of the article [3]. Bibliography available on website should contain exact information about its address [4] and the date of a download to avoid misunderstandings due to the availability of certain materials from time to time.
Due to the differences in the spelling of the British and American language versions, the original texts should be used - in accordance with the text of the cited work. In the British version, the following words of the title are written with a lower case, for example: "Curkovic S., Vickery S.H., Droge C.: Quality and business performance: an empirical study ..." while in the American version all words except the conjunctions are written capitalized - the record would then be: “Curkovic S., Vickery S.H., Droge C.: Quality and Business Performance: An Empirical Study…”.
[bookmark: _Toc480989733]
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STRESZCZENIE

TITLE OF THE THESIS IN POLISH, CAPITAL LETTER, 14 PT FONT, BOLDED AND CENTERED
Name and SURNAME 

The thesis ends with an abstract in Polish, which is a translation of the abstract in English, placed at the beginning of the thesis. The headline of the abstract is not numbered; it is written in capital letters, 11-point font. Below, leaving one line free, is the title of the work, centered, in 14-point bold type. It is followed by the name and surname (written in capital letters) of the author of the thesis.
The text of the abstract is written in 11-point font, Times New Roman CE; paragraph indent is 0.5 cm. The text should be formatted with automatic hyphenation.
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